
 
Vidyut Keyboard, Version 5 (Documentation as of 17 September 2010) Page 1 
 

Vidyut 
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   http://creativecommons.org/licenses/by-nc-sa/3.0/ 
  

http://www.mywhatever.com/sanskrit/vidyut
http://creativecommons.org/licenses/by-nc-sa/3.0/


 
Vidyut Keyboard, Version 5 (Documentation as of 17 September 2010) Page 2 
 

Contents 

 
Overview and Key Features ...................................................................................................................................... 3 
Font Issues ................................................................................................................................................................... 5 
Installation instructions ............................................................................................................................................. 6 
Typing Method ......................................................................................................................................................... 15 
Customization ........................................................................................................................................................... 18 
Keyboard Encoding Table (in Keyboard key order) ............................................................................................ 19 
Keyboard Layout ...................................................................................................................................................... 25 
Keyboard Quick Reference ...................................................................................................................................... 26 

Vowels .................................................................................................................................................................... 26 
Consonants, Semivowels and Sibilants ............................................................................................................. 26 
Numbers and punctuation (standard keyboard positions) ............................................................................ 26 
Deva nā ga rī  punctua ti on ...................................................................................................................................... 27 
Special marks ......................................................................................................................................................... 27 

  



 
Vidyut Keyboard, Version 5 (Documentation as of 17 September 2010) Page 3 
 

Overview and Key Features 

The Vidyut keyboard enables direct typing of Unicode-compliant Deva nā ga rī  a nd  selec ted  
Sanskrit Vedic and metrical marks on Windows computers using a phonetic method.  The keyboard 
generally is consistent with the ITRANS version 5.3 ASCII transliteration schema, with additional 
features to provide marks not mapped in ITRANS.  Both Google and Microsoft have released 64-bit IMEs 
for Indic languages that include phonetic virtual keyboards, but to date none of the available alternatives 
provides a robust solution for Sanskrit text, including all marks needed to set the full range of classical 
and Vedic content.  Vidyut provides a more complete alternative for users working with Sanskrit texts. 

The word vidyut (वलद्यतु)् means lightning in Sanskrit. 
 
Key features: 
 

1. Runs on XP, Vista, and Windows 7 
2. Runs on 32-bit and 64-bit operating systems.  Many of the older input method editors 

(IMEs) for Sanskrit were developed on 32-bit computers and do not run on 64-bit 
systems.  Vidyut was developed specifically to fill a need on 64-bit systems but also runs 
on older 32-bit systems. 

3. Includes all Deva nā ga rī  characters normally used in classical Sanskrit.  Characters 
included are a subset of Unicode Devanāgarī range (0900-097F) plus additional common 
punctuation and other marks. 

4. Includes all Vedic marks necessary to set Ṛgveda, including udā tta (  ॑), a nudā tta (  ॑), and 
cerebral ḻ (ऱ).  E.g., RV 1.1.1: ॲ अ विभ  ऱे ऩ ु योवश त ंम सस्य  दे लभ  विज भ ् । शोता यं यत्न धात भभ ् ॥ १.१.१ ॥ 

5. Includes guru (◌ ̄) and laghu (◌̆) metrical marks for scansion of poetic meter (e.g., ग̄ and 
ग̆) [Chandas font only.] 

6. Uses only the unshifted and SHIFT states of the keyboard; no use of CONTROL or ALT 
keys improves compatibility with most hardware. 

7. Zero Width Joiner (U+200D) gives user the option to manually type joined forms, 
overriding automatic formation of ligatures if desired. (e.g., क् त versus क्त) 

8. Can be fully customized for individual needs using Microsoft Keyboard Layout Creator 
1.4.  All customized derivative keyboards are subject to the terms of the Creative 
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Commons Attribution-NonCommercial-ShareAlike 3.0 Unported License under which 
the Vidyut keyboard itself is distributed. 
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Font Issues 

The Vidyut keyboard is Unicode compliant and will work with any Unicode compliant font, with 
the exception of some special marks as noted below that do not appear in all fonts.  Microsoft ships 
standard Unicode fonts with its operating systems, e.g., Arial Unicode MS (now deprecated), Kokila, 
Mangal, etc.   

Most U nic od e Deva nā ga rī  f ont s o nly incl ude  the ba s ic ele ment s of  t he Deva nā ga rī  writi ng s yste m 
as standardized in the Unicode range 0900-097F (http://unicode.org/charts/PDF/U0900.pdf).  That 
range does not include all of the marks that are needed to set Vedic text or to show metrical scansion.  
Two fonts that provide a superset of the basic range are Sanskrit 2003 and Chandas. 

 
Sanskrit 2003 
We recommend the Sanskrit 2003 font for general use.  Sanskrit 2003 is available as a free 

download (http://www.omkarananda-ashram.org/Sanskrit/itranslator2003.htm).  It is not necessary to 
use the Itranslator software to use the Sanskrit 2003 font.  It is a standard Unicode font that can be 
installed on your system and used with any application that supports Unicode.  The ligature set provided 
by Sanskrit 2003 is superior to most other fonts. 

 
Chandas 
Chandas is a Devanagari Unicode Open Type font with a very large ligature set.  Chandas is 

available as a free download (http://www.sanskritweb.org/cakram/).  Chandas is one of the only fonts 
with the complete set of marks needed to set Vedic text, metrical marks, and many additional signs not 
found in other Sanskrit fonts.  Because most of these marks are not supported in other fonts, and because 
Vedic marks were only standardized in Unicode in 2009, Chandas uses the Private Use Area for these 
special marks.  The Vidyut keyboard maps a few of the most useful marks from the Private Use Area of 
Chandas.  If you require keyboard access to the complete Chandas font, we recommend that you install 
the Chandas Input Method Editor as an additional keyboard option for your system (32-bit only; 64-bit 
not supported as of August 2010). 
 
  

http://unicode.org/charts/PDF/U0900.pdf
http://www.omkarananda-ashram.org/Sanskrit/itranslator2003.htm
http://www.sanskritweb.org/cakram/


 
Vidyut Keyboard, Version 5 (Documentation as of 17 September 2010) Page 6 
 

Installation instructions 

1. If you have an older version of the Vidyut keyboard installed on your system, before installing a new 
version completely uninstall the older version by using "Add and Remove Programs" (in XP) or 
"Programs and Features" in Vista and Windows 7.  In those listings Vidyut may be shown as 
“ S a nskrit Vidyu t Ph onet ic Keyboa rd ”  or “ Ph onet ic KB  f or S a nskrit – Custo m” . 

 
2. You do not need to remove other Sanskrit keyboards prior to installing Vidyut.  If you already have a 

Sanskrit keyboard such as the Google Sanskrit Input or the Microsoft Indic Language Input Method 
Editor, the Vidyut keyboard will be added as an additional keyboard option.  You may have multiple 
Sanskrit keyboards installed on your system.  If you have multiple Sanskrit keyboards installed, you 
will configure your Language Options later to determine which of these keyboards is the default. 

 
3. Download the Vidyut zip file, which will have a version number and release date as part of the file 

name.  The current file name is vidyut5_asof_20100829.zip. 
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4. Extract all of the files from the Vidyut zip file before beginning the installation.  Do not try to run the 
installer from within the zip file, as this may cause the installation to fail.  Do not extract only some of 
the files, as this may cause the installation to fail.  To extract all of the files do a right click on the .zip 
file (vidyut5_asof_20100829.zip) and then select “Extract All…”.  In Windows XP the Extraction 
Wizard will start.  In Windows 7 you will then see a dialog box asking where you want to store the 
extracted files.  You can place the extracted files in any folder you want. 

 

 

 
After you have extracted all of the files you will have a normal folder on your system that looks like this: 
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5. Run the setup.exe file by double clicking it.  You do not need to select a version of the software.  The 

setup installer will detect the version of Windows that you have and do the correct installation 
automatically.  The zip file includes all of the files needed to handle both 32-bit and 64-bit systems.  
When the setup installer begins, Windows may report that the Publisher is "unknown", which is 
normal for this package.  The system will ask for permission to continue with the installation.  After 
authorizing the installation, be patient and give the installer time to complete.  It is a silent installer 
and does not show a progress indicator.  If the installation runs correctly you will see the final 
"Installation Complete" message: 

 

 
 
6. Because keyboard changes affect hardware, you may need to restart your system to ensure that the 

new keyboard will be available as an option.  We recommend a restart on most systems to ensure that 
the new .dll file is activated. 
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7. To verify that Vidyut has been installed, you may look in "Add and Remove Programs" (in XP) or 
"Programs and Features" in Vista and Windows 7 to see the Vidyut listing.  If it does not appear, you 
may need to restart your system and check again. 
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8. To verify that the Vidyut keyboard is now associated with the Sanskrit ("SA") language on your 
Language Bar, right-click the Language Bar and select "Settings".  If you did not have another 
keyboard previously installed as your Sanskrit default, the Vidyut keyboard should now be shown as 
the d ef a ult.   It ma y be  li ste d  a s Vidyut or i t ma y be  li s ted  a s “ Phonet ic KB  f or S a nskri t – Custo m”  a s 
shown below: 

 

 
 
9. Once the Vidyut keyboard is installed as the default keyboard for Sanskrit you may enter Sanskrit 

typing mode by selecting "SA" on the language bar. 
 
10. If you had another keyboard associated with Sanskrit before installing Vidyut, the Vidyut keyboard 

will be added as an option below previously-installed keyboards.  The first keyboard in the list is the 
default keyboard.  In the example shown below, the Google Sanskrit Input keyboard was previously-
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installed as the default for Sanskrit.  After installing Vidyut,  the V idyut Keyb oa rd  ( “ Phonetic KB  f or 
Sanskrit - Cus to m” ) was added as the second option, below the previous Google default.  In this 
listing order the Google keyboard is still the default. 
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11. To change the default order of keyboards, if you have more than one, use the Move Up and Move 
Down keys.  The picture below shows the Vidyut keyboard (listed as "Phonetic KB for Sanskrit - 
Custom") moved above the Google Sanskrit Input. 
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12. If you installed the Vidyut keyboard but it does not appear as a Sanskrit keyboard in your Language 
Bar settings, you may add it to the Language Bar manually.  In the example shown below, the Vidyut 
keyboard has not yet been added as an option.  To add Vidyut as an option, select "Sanskrit (India)" 
as the language, then click the “Add” button. 
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13. A s sho wn be lo w, in t he “ A d d  Input L a ngua ge”  d ia lo g  box scroll down to "Sanskrit (India)" and check 
the box to add the Vidyut keyboard  The Vidyut keyboard may be listed as "Phonetic KB for Sanskrit 
- Custom".  Click "OK". 
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Typing Method 

The Deva nā ga rī  writi ng sys tem f orm s sha pe s ba sed  o n comple te sylla ble s.  If  you t hin k in ter ms of  
forming one syllable at a time you will make fewer errors.  In the following examples, the keys you 
would press are shown in red. 
 

1. Consonants, semi-vowels, and sibilants include the vowel अ (a) as part of their standard form.  To 
type a consonant with no vowel sound (a half-form or halant) type virā ma  ( the f orwa rd  sla sh)  
after the consonant: 

 
क = ka ॥ k 
क + ्॑ = क ् = k ॥ k/ 
ल = va ॥ v 
ल + ्॑ =ल ् ॥ v/ 
व = sa ॥ s 
व + ्॑ = व॥् s/ 

 
2. Vowels used at the beginning of words are shown as full forms (अ इ उ, etc.).  Vowels used to 

modify the sound of other letters ( mā trā s) a re  sho wn as vowel marks (ग ुग ूग  ग  ग  गो गौ, etc.) that 
are typed following the letter they modify. 

 
अ ॥ a     उ ॥ f 
आ ॥ `     ऊ ॥ F 
का ॥ क + ॑ा ॥ kA   ल ु॥ ल + ॑ु ॥ vu 
इ ॥ x     ऋ ॥ [ 
ई ॥ X     ग  ॥ gR 
वव ॥ व + व॑ ॥ si    कं ॥ क + ॑ं ॥ kM 
ठ  ॥ ठ + ॑  ॥ QI    क् ॥ क + ्॑ ॥ kH 
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3. Compound characters are typed using virā ma  ( t he f or wa rd  sla sh) .   L iga ture  f or m s ( sa ṁyoga) will 
be created automatically depending on the font you are using. 

 
ष = क + ्॑ + ऴ ॥ k/S 
ङ्ग = ङ + ्॑ + ग ॥ Z/g 
ष्ट = ऴ + ्॑ + ट ॥ S/Q 
ञ्ज = ञ + ्॑ + ज ॥ Y/j 
ह्ल = श + ्॑ + र ॥ h/l 

 
4. If desired, you can stop the system from automatically creating vertical ligatures by using the 

Zer o W idth J o iner  ke y ( the “ ?”  key) .   The Zer o W idth J oiner  ke y a llo ws you t o d is pla y con so na nt  
half-forms using horizontal ligature variations (e.g., क् त versus क्त). 

 
क् त versus क्त ॥ क + ्॑ + त versus क + ्॑ + ZWJ + त ॥ k/t versus k/?t 
भ् न versus भ्न ॥ ब + ्॑ + न versus ब + ्॑ + ZWJ +  न ॥ B/n versus B/?n 
ङ् ग versus ङ्ग ॥ ङ + ्॑ + ग versus ङ+ ॑ ्+ ZWJ + ग ॥ Z/g versus Z/?g 

 
5. Ve d ic tex ts use a  w ide  va rie ty of  spec ia l a cc en ts a nd  ma rks tha t a re  n ot pa rt of  the Deva nā ga rī  

writing system as standardized in Unicode range 0900-097F 
(http://unicode.org/charts/PDF/U0900.pdf).  That basic range does include three marks that 
a re  usef ul f or Ve d ic tex t s: udā tta  (  ॑) ,  a nudā tta  (  ॑), and cerebral ḻ (ऱ).  Those three characters are 
included in some Unicode Sanskrit fonts.  Verify that the marks are present in whatever font you 
want to use for Vedic text.  The Vidyut keyboard allows you to type them easily if they are 
present in their Unicode standard values.  These marks are sufficient to set Ṛgveda, (e.g. RV 1.1.1: 
ॲ अ विभ  ऱे ऩ ु योवश त ंम सस्य  दे लभ  विज भ ् । शोता यं यत्न धात भभ ् ॥ १.१.१ ॥) but are not sufficient to set Yajurveda, 
S ā ma ve d a ,  or A tha rv a ve d a.  If you need to set those texts consider using the Chandas font. 

 
अ विभ  ऱे ॥ अ + ॒  + ग + ्॑ + न + व॑ + भ +॑  +  ॑ +ऱ + ॑े ॥ a@g/nimI!Ve 

 
6. The guru (◌ ̄) and laghu (◌ ̆) metrical marks for scansion of poetic meter (e.g., ग̄ and ग̆) are not 

pa rt of  the Deva nā ga rī  writin g sy stem a s sta nd a rd iz ed  in U nicode range 0900-097F 

http://unicode.org/charts/PDF/U0900.pdf
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(http://unicode.org/charts/PDF/U0900.pdf). and are not found in most Sanskrit fonts.  They are 
present in the Chandas font.  To set metrical text you may either set all of the text in Chandas, or 
set the base text in another font, such as Sanskrit 2003, and then add the metrical marks to the 
base text using Chandas.  The marks can be added to text in the same manner as the Vedic marks 
discussed above.  The examples below are set using the Chandas font. 

 
र̆ ॥ र + ̆ ॥ r$ 
रा̄ ॥ र + ॒ा + ̄ ॥ rA# 

 

7. Numbers and common punctuation marks are typed using their standard keys. 

१,४९३ = (१,००० + ४९३) ॥ 1,493 = (1,000 + 493) 

 

  

http://unicode.org/charts/PDF/U0900.pdf
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Customization 

All functions of the Vidyut keyboard can be fully customized for individual needs.  The Vidyut 
keyboard is distributed with a MSKLC source file (with a .klc extension) that can be opened and 
modified in Microsoft Keyboard Layout Creator 1.4.  All customized derivative keyboards created in this 
manner are subject to the terms of the Creative Commons Attribution-NonCommercial-ShareAlike 3.0 
Unported License under which the Vidyut keyboard itself is distributed.  If you develop a version of 
Vidyut for a special application, the developers would be happy to hear about it.  If the variant works 
well for a special need the developers may consider adding it to the download archive for Vidyut, 
crediting you as the developer of the modified version. 

 
1. Microsoft Keyboard Layout Creator 1.4 can be downloaded from Microsoft 

(http://msdn.microsoft.com/en-us/goglobal/bb964665.aspx). 
 
2. To modify the Vidyut keyboard, select [File > Load Source File]. 
 
3. Navigate to the uncompressed version of the Vidyut zip file to find the MSKLC Keyboard 

file.  The current version of the file is named vidyut_v5_2010827.klc as shown below: 

 
1. Use [File > Save Source File As] to rename the .klc file to something else. 
2. Use [Project > Properties] to edit the name and description of your variant version. 
3. Use [Project > Build DLL and Setup Package] to create executables.  Be careful 

when naming the new version and select a name that will have clear version information.  
Place it in a new directory, not back into the original vidyut5 directory.  One the setup 
package has been created you can run it and install it on your system to add it as an 
additional keyboard option in your Language preferences. 

  

http://msdn.microsoft.com/en-us/goglobal/bb964665.aspx
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Keyboard Encoding Table (in Keyboard key order) 

In this table cells that are not included in the ITRANS or IAST standards are shown in dark grey.  
Typesetting examples of how the keys render in three different fonts are shown in the rightmost columns 
(Sanskrit 2003, Kokila, and Mangal), with rendering errors shown in light grey. 
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` आ aa or A ā Vowel l on g ā U+0906 आ अ आ 
1 १   एक U+0967 १ १ १ 
2 २   वि U+0968 २ २ २ 
3 ३   वि U+0969 ३ ३ ३ 
4 ४   चतयु ् U+096A ४ ४ ४ 
5 ५   ऩञ्च U+096B ५ ५ ५ 
6 ६   ऴऴ ् U+096C ६ ६ ६ 
7 ७   वप्त U+096D ७ ७ ७ 
8 ८   अष्ट U+096E ८ ८ ८ 
9 ९   नल U+096F ९ ९ ९ 
0 ०   ळनू्यभ ् U+0966 ० ० ० 
- –   En Dash U+2013 – – – 
= =   Equals Sign U+003D = = = 
q ट Ta ṭa  U+091F ट ट ट 
w ड Da ḍa  U+0921 ड ड ड 
e ॑े e e Vowel Sign e U+0947 ग े गे गे 
r य ra ra  U+0930 य र य 
t त ta ta  U+0924 त त त 
y म ya ya  U+092F म य म 
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u ॑ु u u Vowel Sign short u (उ) U+0941 ग ु ग ु ग ु
i व॑ i i Vowel Sign short i (इ) U+093F वग िग गग 
o ॑ो o o Vowel Sign o (ओ) U+094B गो गो गो 
p ऩ pa pa  U+092A ऩ प ऩ 
[ ऋ RRi or R^i ṛ Vowel ṛ U+090B ऋ ऊ ऋ 
] ऌ LLi or L^i ḷ Vowel ḷ U+090C ऌ ऋ ऌ 
\ ।   Daṇḍa (दण्ड) U+0964 । । । 
a अ a a Vowel a U+0905 अ ऄ अ 
s व sa sa  U+0938 व स व 
d द da da  U+0926 द द द 
f उ u u Vowel u U+0909 उ ई उ 
g ग ga ga  U+0917 ग ग ग 
h श ha ha  U+0939 श ह श 
j ज ja ja  U+091C ज ज ज 
k क ka ka  U+0915 क क क 
l र la la  U+0932 र ल र 
; ओ o o Vowel o U+0913 ओ ओ ओ 
‘ ॱ .a  Avagraha (अलग्रश) U+093D ॱ ऽ ॱ 
z ळ sha śa  U+0936 ळ श ळ 
x इ i i Vowel i U+0907 इ आ इ 
c च cha ca  U+091A च च च 
v ल va or wa va  U+0935 ल व ल 
b फ ba ba  U+092C फ ब फ 
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n न na na  U+0928 न न न 
m भ ma ma  U+092E भ म भ 
, ,   Comma U+002C , , , 
. .   Period (Full Stop) U+002E . . . 
/ ्॑ .h  Virā ma  (वलयाभ) = 

Halant (शरन्त) 
U+094D ग ् ग ् ग ्

~ ॲ OM or 
AUM 

  U+0950 ॲ ॎ ॲ 

!  ॑   U d ā tta  (उदात्त) U+0951 ग  ग ॏ गो 
@  ॑   A nudā tta  (अनदुात्त) U+0952 ग  गॐ ग॒ 
# ◌̄   Combining metrical mark guru 

(गरुु) = Combining macron. 
Chandas font only. S a nskrit       
conta i ns a n er ror,  ma ppi ng a  
d ouble stre s s ma rk (      )  to the 
value U+0304. 

U+0304 
Chandas 
only ग̄ ग  ग  

$ ◌̆   Combining metrical mark laghu 
(रघ)ु = Combining breve. 
Chandas font only. Sanskrit 2003 
does not contain the value 
U+0306. 

U+0306 
Chandas 
only ग  ग  ग  

%  ॑ .N  Combining Candrabindu 
(चन्द्रवफन्दु) 

U+0901 ग  गँ गॉ 

^  ॑ RRI or 
R^I 

ṝ Vowel sign long ṝ (क) U+0944 ग  ग ॄ गॄ 

&    Cakram, Chandas font only, 
private use area 

U+F127, 
Chandas 
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only 
*    Svastika, Chandas font only, 

private use area 
U+F120, 
Chandas 
only 

   

( (   Left Parenthesis U+0028 ( ( ( 
) )   Right Parenthesis U+0029 ) ) ) 
_ _   Low Line U+005F _ _ _ 
+ +   Plus Sign U+002B + + + 
Q ठ Tha ṭha  U+0920 ठ ठ ठ 
W ढ Dha ḍha  U+0922 ढ ढ ढ 
E  ॑ ai ai Vowel sign ai (ऐ) U+0948 ग   गै ग ै
R  ॑ RRi or R^i ṛ Vowel sign ṛ (ऋ) U+0943 ग  ग ृ ग ृ
T थ tha tha  U+0925 थ थ थ 
Y ञ ~na or 

JNa 
ña  U+091E ञ ञ ञ 

U ॑ू uu or U ū Vowel sig n lo ng ū (ऊ) U+0942 ग ू ग ू ग ू
I ॑  ii or I ī Vowel sig n lo ng ī  (ई) U+0940 ग  गी गी 
O ॑ौ au au Vowel sign au (औ) U+094C गौ गौ गौ 
P प pha pha  U+092B प फ प 
{ क RRI or 

R^I 
ṝ Vowel long ṝ U+0960 क ॠ क 

} ख LLI or L^I ḹ Vowel long ḹ U+0961 ख ॡ ख 
| ॥   Double Daṇḍa (दण्डिमभ)् U+0965 ॥ ॥ ॥ 
A ॑ा aa or A ā Vowel sig n lo ng ā (आ) U+093E गा गा गा 



 
Vidyut Keyboard, Version 5 (Documentation as of 17 September 2010) Page 23 
 

QW
ER

TY
 

De
va

nā
ga

rī 

ITR
AN

S 
5.3

1 

IA
ST

 

Co
mm

en
t 

Un
ico

de
 

Sa
ns

. 2
00

3 

Ko
kil

a 

Ma
ng

al 

S ऴ Sha ṣa  U+0937 ऴ ष ऴ 
D ध dha dha  U+0927 ध ध ध 
F ऊ uu or U ū Vowel l on g ū U+090A ऊ उ ऊ 
G घ gha gha  U+0918 घ घ घ 
H ्॑ H ḥ Visarga U+0903 ग् गः ग् 
J झ jha jha  U+091D झ झ झ 
K ख kha kha  U+0916 ख ख ख 
L  ॑ LLi or L^i ḷ Vowel sign ḷ (ऌ) U+0962 ग   ग ॢ ग ॢ
: औ au au Vowel au U+0914 औ औ औ 
“ ॰   Deva nā ga rī  a bbr ev ia tion s i gn U+0970 ॰ ॰ ॰ 
Z ङ ~Na ṅa  U+0919 ङ ङ ङ 
X ई ii or I ī Vowel l on g ī U+0908 ई इ ई 
C छ Cha cha  U+091B छ छ छ 
V ऱ   Dev a nā ga rī letter LLA (Unicode 

name).  Used in Ṛgveda (e.g., RV 
1.1.1).  Cf. Macdonell, A Sanskrit 
Grammar for Students, p. 236. 
Transliterated as ḻ in Macdonell. 

U+0933 

ऱ ळ ऱ 

B ब bha bha  U+092D ब भ ब 
N ण Na ṇa  U+0923 ण ण ण 
M ॑ं .n or M ṃ 

(U+1E43) 
A nusvā ra  (अनसु्वाय) 
ISO 15919 uses ṁ (U+1E41) to 
transliterate (॑ं). 

U+0902 
ग ं गं गॊ 

< ए e e Vowel e U+090F ए ए ए 
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> ऐ ai ai Vowel ai U+0910 ऐ ऐ ऐ 
?    Zero Width Joiner. Used for 

alternate typing of joined forms, 
e.g., क् त versus क्त 

U+200D 
  ‍ ‍ 
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Keyboard Layout 

Unshifted state: 

 
 
Shifted state: 
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Keyboard Quick Reference 

Vowels 

 
अ आ इ ई उ ऊ ऋ क ऌ ख ए ऐ ओ औ ॑ं ॑  ्॑ ्॑ 
a ` x X f F [ { ] } < > ; : M % H / 

                  
 ॑ा व॑ ॑  ॑ु ॑ू ॑  ॑  ॑   ॑े ॑  ॑ो ॑ौ     
 A i I u U R ^ L  e E o O     

 

Consonants, Semivowels and Sibilants 

 
क = k ख = K ग = g घ = G ङ= Z 
च = c छ = C ज = j झ = J ञ = Y 
ट = q ठ = Q ड= w ढ = W ण = N 
त = t थ = T द = d ध = D न = n 
ऩ = p प = P फ = b ब = B भ = m 
म = y य = r र = l ल = v  
ळ = z ऴ = S व = s   
श = h     
 

Numbers and punctuation (standard keyboard positions) 

 
१ = 1 २ = 2 ३ = 3 ४ = 4 ५ = 5 ६ = 6 ७ = 7 ८ = 8 ९ = 9 ० = 0 
 
, 

Comma 
. 

Period 
( 

Left 
Parenthesis 

) 

Right 
Parenthesis 

+ 

Plus Sign 
= 

Equals 
Sign 

- 

En Dash 
_ 

Low Line 
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Devanāgarī punctuation 

 
। \ Daṇḍa (दण्ड) 
॥ | Double Daṇḍa (दण्डिमभ)् 
ॱ ‘ Avagraha (अलग्रश) 
॰ “ Deva nā ga rī  a bbr ev ia tion s i gn 
 

Special marks 

 
ॲ ~ Oṁ 
 ॑ ! U d ā tta  (उदात्त) 
 ॑ @ A nudā tta  (अनदुात्त) 

◌̄ # Combining metrical mark guru (गरुु) = Combining macron. Chandas font only. S a nskrit 
     conta ins a n er ror,  ma pping a  d oub le stre ss ma rk (      )  to the va lue U      . 

◌̆ $ Combining metrical mark laghu (रघ)ु = Combining breve. Chandas font only. Sanskrit 
2003 does not contain the value U+0306. 

 & Cakram, Chandas font only, private use area 

 * Svastika, Chandas font only, private use area 

ऱ V Dev a nā ga rī letter LLA (Unicode name).  Used in Ṛgveda (e.g., RV 1.1.1).  Cf. 
Macdonell, A Sanskrit Grammar for Students, p. 236. Transliterated as ḻ in Macdonell. 

 ? Zero Width Joiner. Used for alternate typing of joined forms, e.g., क् त versus क्त 
 
 
 


